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What is new in this release? 
All sections have been updated per your requests, check particularly: 

• New derivatives supported (see specifications, service packs) 
• New Device Initialization section 
• Connection support for RS08 microcontrollers 
• More on licensing, getting started, links, documentation and Q&A’s 



 
 

© Freescale, LRR 5/22/2006 @ 5:01 PM  3 

 

 
1 CodeWarrior Development Studio for HC(S)08/RS08 
CodeWarrior Development Studio for HC(S)08/RS08 is an integrated suite of tools containing all the 
components needed to bring an application from the concept stage to the release to the market of a finished 
product. 
 
CodeWarrior Development Studio contains the following set of tools: 

*  Integrated Development Environment (IDE) 
*  Project Wizard, Project Manager 
*  Processor Expert™ with Beans™ (1) 
*  Device Initialization™ (2) 
*  Editor, Compiler, linker and Macro/Absolute Assembler  
*  Graphical Debugger with new Debug Module and multi-target interface capability 
*  Simulator with Data Visualization and I/O Stimulation (3) 
*  Flash programming tools 
*  Many features can be set to user’s preferences with the project preferences panel and the targets 
preferences panels. 

 
(1) Processor Expert helps save design time by assisting the user in the definition of the application 
environment and generating support code without having to read and learn a lot about the device, its 
peripherals, the registers and their bit field settings. 
(2) Device Initialization  
 (3) Data Visualization helps save debugging time (especially with the simulator before hardware is 
available) by providing a graphical display of bit status and byte values. I/O Stimulation provides graphical, 
real-time control of bit levels or byte values as inputs to the application. 
 
An evaluation copy can be requested from Freescale.  
It is possible to evaluate the full featured Professional Edition by requesting a license, free of charge, valid 
for 30 days. Contact your Freescale salesperson or distributor. 
 

2 Specifications 

2.1 Version of products 
Release 5.1  Current release of CodeWarrior Development Studio for HC(S)08/RS08 
 

• The EY16A service pack supporting the M68HC908EY16A and MC68HC908EY8A will be posted 
on the CodeWarrior download page in June 2006. It will be on the July Service Pack CD. 

• The JR12 service pack support the MC9S08JR12 will be posted on the CodeWarrior download page 
in June 2006. It will be on the July Service Pack CD. 

 

2.2 Processors supported by the current release (without service pack) 
CodeWarrior supports all the HC08 and HCS08 derivatives in production at the time of its development. New 
derivatives are (and will be) supported by ‘Service Packs’ until the next release (see following section). 
For latest updates, link to download HC(S)08 Service Packs .  
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  - AB: AB32 
*- AP: AP8, AP8A, AP16, AP16A, AP32, AP32A, AP64, AP64A 
  - AS: AS60, AS60A 
*- AW: AW32, AW48, AW60 
  - AZ: AZ32A, AZ60A 
  - BD:  BD48 
  - EY: EY8, EY8A, EY16, EY16A 
*- GB/GT: GB32, GB32A, GB60, GB60A, GT16, GT32, GT32A, GT60, GT60A 
  - GP/GT: GP32, GT8, GT16,  
  - GR: GR4, GR8, GR16, GR16A, GR32A, GR48A, GR60A 
  - GZ: GZ8, GZ16, GZ32, GZ48, GZ60 
  - JB: JB8, JB12, JB16 
  - JG: JG16 
  - JK: JK1, JK3, JK8, JK16 
  - JL: JL3, JL8, JL16 
  - JW: JW32 
#- KA: KA2 
  - KX: KX2, KX8 
  - LB: LB8 
  - LD: LD64 
  - LJ: LJ12, LJ24 
  - LK: LK24 
  - LT: LT4, LT8 
  - LV: LV8 
  - MR: MR8, MR16, MR32 
  - QB: QB4, QB8 
  - QC: QC4, QC8, QC16 
*- QG: QG4, QG8 
  - QL: QL2, QL3, QL4 
  - QT: QT1, QT1A, QT2, QT2A, QT4, QT4A, QT8 
  - HLC908QT: QT1, QT2, QT4 
  - QY: QY1, QY1A, QY2, QY2A, QY4, QY4A, QY8 
  - HLC908YT: QY1, QY2, QY4 
  - RF/RK: RF2 
  - SR: SR12 
*- RC: RC8, RC16, RC32, RC60 
*- RD: RD8, RD16, RD32, RD60 
*- RE: RE8, RE16, RE32, RE60 
*- RG: RG32, RG60 
 
Note:  
*  Denotes HCS08 derivatives with new background debug module. They are supported by a BDM target 

interface. 
# Denotes RS08 derivatives, which are supported by a BDM target interface. 
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2.3 Service Packs available for new derivatives 
Service Packs are packages developed to support new derivatives (full new stationery or complement of the 
stationery). “New derivatives” are devices introduced after the release of CodeWarrior. 
Service packs are available from our web site (see links at the end of this document). Whenever possible, 
these service packs will be integrated into the next release. 
 
Service Packs for Release 3.1: 
 

• CW08 V3.1 USB Service Pack    (February 3, 2005) Adds USB 2.0 support for USB Mon08 and 
BDM Multilinks, adds SYNCH support, 
displays CPA connection information 

• CW08 V3.1 FSICEBASE Service Pack (March 15, 2005) Adds support for following EMs with new 
FSICE emulator: EML908KX, EM08MR32, 
EM08AS60, EM08AZ60, EML08GZ, 
EML08QTQY, EML08SR, EM08BD48, 
EML08AB32, EML08GP32, EML08LJLK, 
EML08JBJG, EM08JB, EML08RK/RFRK, 
EM08EY, EML08AP 

• CW08 Processor Expert V2.95 (March 17, 2005) Adds Processor Expert support for the 
following derivatives: GT16, GT60 in new 
48-pin package, JB8 in new 24-pin package, 
QT8, RC8, RD8, RE8. Also contains  
assembly include files for AB16A, AZ32, 
AZ32A. 

• CW08 V3.1 LB Service Pack (March 17, 2005) LB8, LB4 
• CW08 V3.1 JW32 Service Pack (March 17, 2005) JW32 
• CW08 V3.1 FSICEBASE Service Pack (April 19, 2005) Re-release adding support for following 

EMs: EML08GPGT, EML08GZ16, 
EML08JL8, EML08JLJK, EM08JW32, 
EM08LB8, EML08LD64, EML08LJ12, 
EM08MR8, EML08QBLTY, EML08QL 

• CW08 Processor Expert V2.96 (May 23, 2005) Adds Processor Expert support for the 
following derivatives: GR16A, GR32A, 
GR48A, GR60A, AP64A, JL16, JK16, 
AW60, AW48, AW32. Also contains 
updated C header and assembly include files 
for the following derivatives: QL4, QL3, 
QL2. 

• CW08 V3.1 GR60A Service Pack    (June 29, 2005) GR60A, GR48A, GR32A, GR16A 
• CW08 V3.1 AW60 Service Pack    (June 29, 2005) AW60, AW48, AW32 
• CW08 V3.1 AP64A Service Pack    (June 29, 2005) AP64A, AP32A, AP16A, AP8A 
• CW08 V3.1 GB60A Service Pack (June 29, 2005) GB32A, GB60A, GT32A, GT60A 
• CW08 V3.1 QG8 Service Pack (October 25, 2005) QG8, QG4 
• CW08 Processor Expert V2.97 (November 4, 2005) Adds Processor Expert support for the 

following derivatives: JL3, QC16, QC8, 
QC4, EY8, QG8, QG4, MC13213, 
MC13212, and MC13211 

• CW08 V3.1 QY4A Service Pack (November 30, 2005) QT4A, QT2A, QT1A, QY4A, QY2A, 
QY1A 

• CW08 V3.1 LV8 Service Pack (February 2, 2006) LV8 
• CW08 V3.1 QC16 Service Pack (February 21, 2006) QC16, QC8, QC4 
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• CW08 V3.1 LT8 Service Pack (February 21, 2006) LT8, LT4 
• CW08 V3.1 Programming Algorithms (February 21, 2006) Updates programming algorithms for all 

HC(S)08 derivatives for all P&E 
Multilinks, Cyclones, and Cyclone Pros 

 
Service Packs for Release 5.0: 

• CW08 V5.0 Patch 1 (February 21, 2006) Corrects non-volatile register 
declarations in the header files and 
automatically generated code 

• CW08 V5.0 LV8 Service Pack (February 2, 2006) LV8 
• CW08 V5.0 LT8 Service Pack (February 21, 2006) LT8, LT4 
• CW08 V5.0 QC16 Service Pack (May 5, 2006) Add FSICE support for QC16 & QC8 

 

2.4 Board supported (see also the hardware section) 
We try to have stationery support for evaluation boards that we receive information on (see useful links 
section.). This support can take the form of a stationery folder generated by the CodeWarrior Team or by the 
vendors themselves (see section on useful links). The support can also be in the form of a tutorial on how to 
download and run the code. 
 
Freescale All ICS and EM boards available from Freescale 
 68HC908QT4 Evaluation Board (tutorial available separately) 
 
Axiom M68DEMO908GB60 
 M68EVB908GB60 
 
SofTec Microsystems InDART and PK solutions are supported by CodeWarrior (SofTec CD). 
 There are solutions for both HC08 and HCS08 derivatives. 
 See ‘Questions and Answers’ for the stationery supporting this. 
 
Future Electronics 908Badge Boards (Tutorial available from Future Electronics) 
 

2.5 Languages 
CodeWarrior Development Studio for HC(S)08/RS08 supports a wide range of languages from absolute 
assembly to C++ with compact C++ for small memory footprints.  

2.5.1 Assembly 
Develop in the old way with absolute assembly or in a more complex form with multiple relocatable 
assembly files, cross-referenced labels and variables but still close to the code with full control of the 
performance. 
There is no code size limitation on development in assembly mode. 

2.5.2 C 
C is code-size limited to 16Kbytes of code in the ‘free of charge’ Special Edition. There are two upgrade 
license keys from the Special Edition: a 32Kbytes and a 64Kbytes. C is unrestricted with the Standard 
Edition and the Professional Edition. The C compiler supports the HC(S)08 microcontrollers. 
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2.5.3 C++, Compact C++ and EC++ 
C++ is limited to 1Kbytes of code in the Special and the Standard Edition. There is an upgrade license key 
for the Standard Edition. C++ is unrestricted with the Professional Edition. The C++ compilers support 
the HC(S)08 microcontrollers. 

2.5.4 Language support 
Each template in the stationery also contains header files with description of registers, bytes and bits as 
they appear in the derivatives’ user manuals to make easier the writing of the code. Templates have the 
project entirely set up so that developers can concentrate on writing the application code in the ‘main’ 
section of the program as indicated in the source file: “ /* write your code here */ ”. 
Templates are also prepared for several “targets” allowing the developer to select the right set of files and 
move quickly from full simulation to evaluation board and customer’s target without extra work. 

 

3 Unrivaled Features but so easy to use 
CodeWarrior Development Studio for HC(S)08/RS08 has been designed to simplify the development of 
microcontroller-based applications by helping engineers concentrate on the key part of their project: writing 
the code. CodeWarrior can be made as simple to use as small assembly-code applications require or as 
feature-full as the most demanding developers can ask for. Furthermore, CodeWarrior for HC(S)08 combines 
several tools whose features are unrivaled today: The Processor Expert tool at the definition phase of a 
project with its libraries of standard, complex and software beans™, and the enhanced Simulator/Debugger 
with Data Visualization and I/O Stimulation capability to shorten the debugging phase of a project. 

3.1 Smart Linker 

The smart linker is a panel with graphical adjustment of different 
parameters to optimize the code. No need to remember complex 
command lines to set multiple parameters during compilation and 
linking process. More than 50 different optimizations can be achieved 
with the control panel of the Smart Linker. Adjust for code density, 
execution speed, compilation time or information available from the 
tools and the equivalent command line is displayed so you can remember 
what setting was used.  
See ‘useful links’ and ‘documentation’ 

3.2 Device Initialization  
Device Initialization provides a fast and easy way to 
configure and generate initialization code for HC(S)08 
microcontrollers. The Device Initialization tool contains 
only one set of beans: Peripheral Initialization Beans. 
The initialization code can be generated in either 
assembly or C code. 
 
During the Code Generation process the Device 
Initialization tool generates a function named MCU_Init 
with the initialization code for the CPU peripherals the 
user selected - configured to the user’s specifications. 
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To use the MCU_Init function – the user just inserts the function call at the start of their application code. 

This tool dramatically saves the time to learn about a new device and the time to correct mistakes and help 
concentrate on the real part of the application, the added value of a project.  
See ‘useful links’ and ‘documentation’ 

3.2.1 Peripheral  Initialization Beans 

The Peripheral Initialization Beans provide the lowest level of hardware abstraction. With Device 
Initialization the user is able to configure the control registers for each of the peripherals on the silicon 
and the Device Initialization tool generates the necessary initialization code in assembly or C code. 

HC08 
- Init_ADC_HC08 Analog-to-Digital Converter (ADC) 
- Init_AnalogModule_HC08 Analog Module (AnM) 
- Init_BDLC_HC08 Byte Data Link Controller (BDLC) 
- Init_COP_HC08 Computer Operating Properly (COP) 
- Init_EEPROM_HC08 EEPROM Memory (EEPROM) 
- Init_GPIO_HC08 General Purpose Input Output (GPIO) 
- Init_HRP_HC08 High Resolution PWM (HRP) 
- Init_IIC_HC08 Inter-IC Bus (IIC) 
- Init_IRQ_HC08 External Interrupt Module (IRQ) 
- Init_KBI_HC08 Keyboard Interrupt Module (KBI) 
- Init_LCD_HC08 Liquid Crystal Display (LCD) 
- Init_MSCAN_HC08 Motorola Scalable Controller Area Network (MSCAN) 
- Init_OpAmp_HC08 Op Amp / Comparator module (OpAmp) 
- Init_OSD_HC08 On-Screen Display (OSD) 
- Init_PPI_HC08 Programmable Periodic Interrupt(PPI) 
- Init_PWM_HC08 Pulse Width Modulator (PWM) 
- Init_PWMMC_HC08 Pulse-Width Modulator for Motor Control (PWMMC) 
- Init_PWU_HC08 Periodic wakeup module (PWU) 
- Init_RTC_HC08 Real Time Clock (RTC) 
- Init_SCI_HC08 Serial Communications Interface (SCI) 
- Init_SLIC_HC08 Slave LIN Interface Controller (SLIC) 
- Init_SPI_HC08 Serial Peripheral Interface (SPI) 
- Init_SyncProc_HC08 Sync Processor 
- Init_TBM_HC08 Timebase Module (TBM) 
- Init_TIM_HC08 Timer Interface Module (TIM) 
- Init_USB_HC08 Universal Serial Bus (USB) 
- Init_USBHUB_HC08 Universal Serial Bus (USBhub) 

HCS08 
- Init_ACMP_HCS08 Freescale Analog Comparator (ACMP) 
- Init_ADC_HCS08 Analog-to-Digital Converter (ADC) 
- Init_AWT_HCS08 AutoWake-up Timer module (AWT) 
- Init_CMT_HCS08 Carrier Modulator Transmitter (CMT) 
- Init_COP_HCS08 Computer Operating Properly (COP) 
- Init_FLASH_HCS08 Flash Memory (FLASH) 
- Init_GPIO_HCS08 General Purpose Input Output (GPIO) 
- Init_IIC_HCS08 Inter-IC Bus (IIC) 
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- Init_IRQ_HCS08 External Interrupt Module (IRQ) 
- Init_KBI_HCS08 Keyboard Interrupt Module (KBI) 
- Init_MTIM_HCS08 Modulo Timer (MTIM) 
- Init_RTI_HCS08 Real Time Interrupt (RTI) 
- Init_SCI_HCS08 Serial Communications Interface (SCI) 
- Init_SPI_HCS08 Serial Peripheral Interface (SPI) 
- Init_TPM_HCS08 Timer/PWM (TPM) 

RS08 
- Init_ACMP_RS08 Freescale Analog Comparator (ACMP) 
- Init_COP_RS08 Computer Operating Properly (COP) 
- Init_GPIO_RS08 General Purpose Input Output (GPIO) 
- Init_KBI_RS08 Keyboard Interrupt Module (KBI) 
- Init_MTIM_RS08 Modulo Timer (MTIM) 
- Init_RTI_RS08 Real Time Interrupt (RTI) 

See ‘useful links’ and ‘documentation 

3.3 Processor Expert™ 

Processor Expert is a Rapid Application Design (RAD) tool that combines easy-to-use component based 
application creation with an expert knowledge system. Functionality of CPU and on-chip peripherals as well 
as higher levels of specific applications are encapsulated into components called Embedded Beans. 

This powerful tool frees up developers from the long effort of learning bits and bytes of new peripherals and 
how to properly set them up to implement the desired functions. It allows the developer to describe how 
built-in peripherals and their hardware environment will be used and it automatically generates the code to 
properly initialize, write to and read these peripherals. 

This tool dramatically saves the time to learn about a new device and the time to correct mistakes and help 
concentrate on the real part of the application, the added value of a project.  

3.3.1 Processor Expert Beans 

3.3.1.1 Basic Beans 

Basic Beans (or standard beans) refer to the basic blocks such as parallel ports, timers, A/D converters, 
and simple serial interfaces as well as simple functions using them. The Basic Beans are listed below. 
Basic Bean support is dependent on the peripherals and pins available on a particular derivative. 

- ADC A/D converter 
- AsynchroSerial Asynchronous serial communication 
- BitIO General 1-bit Input/Output 
- BitsIO General Multi-Bits Input/Output (1-8 bits) 
- BWimage Black & White image 
- Byte2IO General Two-Bytes Input/Output 
- Byte3IO General Three-Bytes Input/Output 
- Byte4IO General Four-Bytes Input/Output 
- ByteIO General Byte Input/Output (8 bits) 
- Capture Timer capture encapsulation 
- COLimage Color image 
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- EventCntr16 Event counter 16-bit 
- EventCntr32 Event counter 32-bit 
- EventCntr8 Event counter 8-bit 
- ExtInt External interrupt 
- FreeCntr16 Free running 16-bit counter 
- FreeCntr32 Free running 32-bit counter 
- FreeCntr8 Free running 8-bit counter 
- FreescaleHRP High Resolution PWM 
- FreescaleOpAmp Op Amp / Comparator module 
- IntEEPROM Internal EEPROM 
- InterruptVector Interrupt vector handled in user code 
- PPG Programable pulse generation 
- PWM Pulse width modulation 
- RTIshared Real Time Interrupt Shareable 
- SW_I2C SW emulated I2C using two I/O pins. 
- SWSPI Software synchronous serial communication 
- SynchroMaster Master for synchronous serial communication 
- SynchroSlave Slave for synchronous serial communication 
- TimerInt Periodic interrupt 
- TimerOut Flip-flop output 1:1 
- WatchDog WatchDog beanSee ‘useful links’ and ‘documentation 

3.3.1.2 Software Beans 

The Software Beans library is a collection of software modules developed to interface to popular 
external peripherals such as serial SPI sensors, LCD modules, Flash memory modules, A/D and D/A 
converters as well as implementing low level functions such as keyboard matrix, software SPI function, 
7-segment display or simple FFT or FIR functions. These beans are ‘free of charge’ to customers 
purchasing the Standard Edition or Professional Edition of CodeWarrior. 

3.3.1.3 Advanced Beans 

Advanced Beans (or complex beans) refer to the beans supporting complex peripherals such as complex 
A/D conversions. Advanced Beans are available to customers purchasing the Professional Edition of 
CodeWarrior. The Advanced Beans are listed below. Advanced Bean support is dependent on the 
peripherals and pins available on a particular derivative. Advanced Beans are available to customers 
purchasing the Professional Edition of CodeWarrior. 

HC(S)08 
- AsynchroMaster Asynchronous serial communication - master 
- AsynchroSlave Asynchronous serial communication - slave 
- ExternalFile External Binary File Converter 
- InternalI2C Internal I2C Communication Interface 
- KBI Keyboard  
- StringList String List Converter 
- Term ANSI Terminal 
- TimeDate Time and date 
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HC08 Only 
- BDLC BDLC serial communication (HC08) 
- DDC1 DDC1 communication interface (HC08) 
- FreescaleAnalogModule Freescale Analog module (HC08) 
- FreescaleBEMF Back ElectroMagnetic Force (HC08) 
- FreescaleCAN CAN communication for Freescale implementation (HC08) 
- FreescalePWM Pulse width modulation - special version (HC08) 
- FreescaleUHFTransmitter UHF Transmitter (HC08) 
- LCD Liquid Crystal Display (HC08) 
- OSD On-Screen Display (HC08) 
- PWMMC Pulse width modulation for motor control (HC08) 
- RTC Real Time Clock (HC08) 
- SyncProc Sync Processor (HC08) 
- USB USB device bean (HC08) 
- USBHUB USB HUB device (HC08) 

HCS08 Only 
- FreescaleAnalogComp Analog comparator on Freescale HCS08 derivates 
- FreescaleCMT Freescale Carrier Modulator Transmitter (HCS08) 
- IntFLASH Internal FLASH (HCS08) 

 
 
See ‘useful links’ and ‘documentation 
 

3.3.2 Bean Wizard™ 

The Bean Wizard™ is the tool that allows you to create your own beans that address the specific needs of an 
application, like the support of using a generic peripheral in a very specific way. 
 

3.4 Data Visualization & I/O Stimulation 

The Data visualization, with the complementary function of I/O stimulation is 
a tool that allows the developer to attach graphical representation of hardware 
functions to the input and/or output registers of peripherals and display the 
real-time status of the functions implemented by the peripherals. Typical and 
simple examples are LEDs and bar graphs displays, switches and 
potentiometers. 

Command files can be attached to these functions to expand the capability to 
provide stimulation and display of the direct environment of the 
microcontroller used for the application, getting closer to the final hardware and before code is downloaded 
in the application. 

This tool significantly accelerates the development of an application by allowing the validation of the 
software part of the application before downloading it to the platform, thus isolating hardware related 
issues. Another benefit is the ability to test and validate “hardware” changes at the simulation level with 
the time and product savings such a feature allows. 
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See ‘useful links’ and ‘documentation’ 

4 Features of Special, Standard and Professional Editions 
CodeWarrior for HC(S)08 is available in different versions to suit customers’ needs. 
 

Special Edition Standard Edition Professional 
Edition 

 
CWX-HXX-SE CWS-H08-STDED-CX CWS-H08-

PROED-CX 

 CWS-H08-C32K-CX CWS-H08-C64K-CX   Compiler Options 
16Kbytes 32Kbytes 64Kbytes Unlimited Unlimited 

CODEWARRIOR 
IDE 5.x 32 files Unlimited Unlimited Unlimited Unlimited 
Macro Assembler Y Y Y Y Y 
Pre-configured Projects Y Y Y Y Y 
Flash Programming Y Y Y Y Y 
Simulator (P&E techn.) Y Y Y Y Y 
Data Visualization 1 component, 3 elements Unlimited Unlimited 
Decoder    Y Y 
Libmaker    Y Y 
Session Record & Play     Y 
OSEK awareness     Y 
PC-Lint Plugins     Y 
PROCESSOR EXPERT 
Basic Beans Y Y Y Y Y 
Software Beans    Y Y 
Advanced Beans     Y 
Bean Wizard     Y 
ENHANCING OPTIONS 
C++                   
compact C++/EC++ 1Kbytes 1Kbytes 1Kbytes Order key  

CWX-H08-ENCHC-KX Y 

TARGETS (parallel, serial or USB) 
HCS08 Serial Monitor Y Y Y Y Y 
P&E Multilink(s) Y Y Y Y Y 
P&E CYCLONE(PRO) Y Y Y Y Y 
SofTec USB Y Y Y Y Y 
HC08 MMDS/MMEVS Y Y Y Y Y 
HC08 FSICE Y Y Y Y Y 
HCS08 DBG support Y Y Y Y Y 
 

4.1 Technical support 
- Technical support gives access to trained application engineers who can help customers, 
- Technical support also entitles customers to purchase new releases with a 70% discount, 
- First year of technical support is included in the price, 
- Subsequent years of technical support must be purchased to continue coverage and be entitled to 

discounts mentioned above. 

4.2 Special Edition 
TARGET: Special edition is targeted at assembly code projects or small projects with a limited amount of C 
code. Debugging is mostly done with Evaluation Boards or directly on the target application. 
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Features: there are some limitations to the special edition: 
- Unlimited assembler for HC(S)08 and RS08 microcontrollers 
- C compiler limited to 16Kbytes of object code for HC(S)08 microcontrollers 

(There is no code size limitation when developing in assembly.) 
- Linker limited to 16K of C code and 1K of C++ 
- IDE limited to 32 files and no sub-project. 
- Projects can have up to 4 targets 
- Data Visualization/IO stimulation allows for 1 component with 3 instruments 

NOTE: The simulator is from P&E Microsystems. 
 

Options available for the Special Edition 
For customers developing C based applications and using more than 16Kbytes of code, two C compiler 
options are available, a 32Kbytes option and a full 64Kbytes option. 
The C compiler upgrade to 32Kbytes offers: 

- C compiler object code increased to up to 32Kbytes (1K of C++) for HC(S)08 microcontrollers 
- No file limitation for the IDE 

The C compiler upgrade to the full 64Kbytes offers: 
- C compiler object code for up to 64Kbytes (1K of C++) for HC(S)08 microcontrollers 
- No file limitation for the IDE 

4.3 Standard Edition 
TARGET: Standard edition is targeted at projects developed with C, assembly or a mix of the languages and 
up to the maximum memory size of the HC(S)08 family. It adds the possibility to closely simulate the 
interfaces to the processor, making the debugging easier and the time to market shorter. 
Features: Standard edition has more features than the special edition: 

- Access to Unis Processor Expert software beans to accelerate application designs 
- Unlimited C compiler / debugger code size (C++ limited to 1Kbytes) for HC(S)08 microcontrollers 
- Unlimited Data visualization/IO stimulation to improve debugging 
- No limitation on number of files in the project and subprojects 

Customers can also upgrade from one of the C upgrades to the Standard Edition. 
 

Enhancing options available for the Standard Edition 
Standard Edition can be complemented with a number of options from the Professional Edition that improve 
developers’ productivity: 

- C++/Compact C++/EC++ 

4.4 Professional Edition 
TARGET: Professional edition is targeted at professional, short time to market applications. Developers 
benefit from a number of unrivaled features available in the CodeWarrior tool suite to develop the most 
complex applications and meet short time to market goals. 
Features: Professional edition includes all the features of the other editions plus: 

- C++/Compact C++/EC++ for HC(S)08 microcontrollers 
- Code Coverage that allows the user to isolate unused or badly used portions of code 
- Profiler/Performance Analysis to identify and optimize critical portions of code 
- Advanced Complex beans providing higher level software modules and faster code integration 
- Bean wizard to build a software library that can be retargeted to any HC(S)08 or HC(S)12 silicon  
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- Session Record and Play for automated testing 
- OSEK awareness for kernel-level debugging 
- Encryption tools 
- PC-lint Plug-in to use PC-lint with CodeWarrior Development Studio (purchased separately from 

Gimpel Software) 
- Support of third Parties emulators (Lauterbach, Hitex). 

 
Customers can upgrade from Standard Edition to Professional Edition. Upgrading from a Special 
Edition C compiler upgrade will be charged as 2 upgrades: a Standard Edition upgrade and a Professional 
Edition upgrade. 

5 Additional Support 
CodeWarrior for HC(S)08 has the capability to provide additional support for specific functions.  

5.1 OSEK 
The CodeWarrior Development Studio for HC(S)08/RS08 Professional Edition is ‘OSEK aware’. 

5.2 PC-Lint 
PC-Lint is a software package that finds errata in your C programs using the K&R and ANSI standards for C. 
The purpose of linting your programs is to determine potential problems prior to integration or porting, or to 
reveal unusual constructs that may be a source of subtle errors. PC-Lint often finds problems that the 
compiler alone cannot. 
The CodeWarrior Development Studio for HC(S)08/RS08 Professional Edition has PC-Lint plugins. 

5.3 MSCAN 
The CAN LLD’s were developed with a Toucan interface for HC08, HC12 and MPC5xx. 

5.4 LIN 
The LIN drivers are available free of charge from Freescale. 
 

6 Why update and upgrade? 
There are multiple reasons to upgrade to a new release, upgrade from Special Edition to Standard and 
Professional Edition but the most important one is that it will save money in the long run by reducing the 
design time, improve re-use and improve the quality of the product, leading to lower maintenance costs. 

6.1 Upgrade to Professional Edition 
These new features are ALL available in the Professional Edition. Check out the 'Release Notes' folder (or 
menu Help > Online Manuals in the IDE). 

- New project wizard: menu File > New and then 'HC(S)08 New Project Wizard. 
- New and updated support for HC(S)08/RS08 families 
- BDM support for HCS08 (featuring on-chip DBG/Trigger module and trace) 
- On-chip DBG module including trace for HCS08 
- New/updated compiler to support HCS08 devices (-Cs08 compiler option) 
- New/updated assembler to support HCS08 devices (-Cs08 assembler option) 
- Updated prm and library files for existing and new derivatives 
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- Updated debugger/simulator files 
- New visualisation tool in the debugger supporting additional instruments/properties 
- Updated online documentation with extended search capability (Help > Online Manuals) 
- New Burner utility to support path suppression in the S0 record 
- New decoder utility to support HCS08 instruction set 
- Updated ClearCase version control plugin 
- Updated PC-lint configuration files (matching latest PC-lint release) 
- P&E PEDebug: new derivatives/FCS 
- Updated Processor Expert supporting new HCS08 architecture 
- Updated Device Initialization Tool supporting new RS08 architecture 

6.2 Upgrade to Standard Edition 
Standard Edition adds many features to the special edition: 

- Data visualization/IO stimulation to improve debugging 
- Access to Unis Processor Expert software beans to accelerate application designs 
- No limitation on C code size 
- No limitation on number of files the linker can handle 
- Decoder to create a listing from ELF files 
- Libmaker to create binary libraries 

Standard Edition also offers the possibility to add C/C++ compiler. 

6.3 Upgrade C compiler of Special Edition 
The C compiler upgrades to 32K or 64Kbytes are for users of the Special Edition requiring more than 
16Kbytes of code for HC(S)08 microcontrollers. The use of C code offers portability, faster debugging and 
design of complex applications that would be very difficult to debug at the assembly level. The C32 upgrade 
allows generating up to 32Kbytes of code and the C64 upgrade up to 64Kbytes of code. 
 
Both upgrades remove the file limitation for the linker of the 16Kbyte initial version. 

7 Software Products: Part numbers 
Base Product Part number 

Special Edition Tri-Pak 
(includes CodeWarrior Development Studio for HC(S)08, CodeWarrior Development 
Studio for HCS12(X), and HC(S)08/HCS12(X) Service Pack CD) 

CWX-HXX-SE 

Standard Edition CWS-H08-STDED-CX 

Professional Edition CWS-H08-PROED-CX 
Options for Special Edition Part number 

C compiler/debugger Upgrade to 32 Kbytes for Special Edition CWS-H08-C32K-CX 

C compiler/debugger Upgrade to 64 Kbytes for Special Edition CWS-H08-C64K-CX 
Options for Standard Edition Part number 

C++ / Compact C++ option for Standard Edition CWX-H08-ENHNC-KX 
Product Upgrades Part number 

Upgrade from Special Edition to Standard Edition CWS-H08-STDED-UX 

Upgrade from Standard Edition to Professional Edition CWS-H08-PROED-UX 
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Technical Support and Product Renewals Part number 

1 year technical support for C compiler upgrade to 32 Kbytes CWT-H08-C32K-UX 

1 year technical support for C compiler upgrade to 64 Kbytes CWT-H08-C64K-UX 

1 year technical support for Standard Edition CWT-H08-STDED-TX 

1 year technical support for Professional Edition CWT-H08-PROED-TX 

8 Hardware Products  
There are several hardware connections available to suit the needs of the most demanding. CodeWarrior has 
built-in drivers to communicate with these different interfaces and make the function transparent to the user. 
Many connections are now available: 

- Standard RS232 to Serial monitor (HCS08 devices with flashed monitor) 
- Multilink USB to Mon08 for HC08 
- Multilink USB to BDM for HCS08 
- CyclonePRO serial/USB/Ethernet to mon08 (HC08) and BDM (HCS08) 
- SofTec inDart USB to Mon08 for HC08 
- SofTec inDart USB to BDM for HCS08 

8.1 Multilinks 
The Multilink is an easy to use, low-cost development tool for Freescale’s 
HC(S)08 Flash MCUs. It provides the interface for in-circuit emulation, 
debugging and programming through the HC(S)08’s standard MON08 or BDM 
serial debug/breakpoint interface. 
 
P&E has recently redesigned the USB Mon08 Multilinks (Rev D) and USB 
BDM Multilinks (Rev C) to be RoHS compliant. P&E also added a charge pump 
to the  USB BDM Multilink to support the higher Flash programming voltage 
required for RS08 microcontrollers.  

8.2 CyclonePRO 
The Cyclone Pro provides all the capabilities of the Multilink plus the ability to 
operate as a standalone programmer with pushbuttons and LEDs to control the 
operations. It supports multiple host-target interfaces: serial, parallel, USB and 
Ethernet to Mon08 and BDM. The Cyclone Pro replaces the Mon08 Cyclone. The 
Cyclone Pro (Rev C) has recently been redesigned to be RoHS compliant and to 
add support for RS08 microcontrollers.  

8.3 InDART (SofTec Microsystems) 
USB-based inDART-HC(S)08 takes advantage of Freescale’s CodeWarrior 
Development Studio for HC08 and the ISP (In-System Programming) feature to 
program the FLASH memory of the target microcontroller. Together with 
CodeWarrior, inDART-HC(S)08 provides you with everything you need to write, 
compile, download, in-circuit emulate and debug user code. inDART-HC(S)08 
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Design Kits come together with an Evaluation Board to permit an easy and fast start-up. C and Assembly 
examples are available for a first debugging process. Contact SofTec Microsystems or Freescale distributors 
directly. 

8.4 In-Circuit Simulation (ICS) 
Freescale's In-Circuit Simulator Kits are our lowest cost tools for developing 
and debugging target systems incorporating Freescale's most popular HC08s. 
In-circuit simulation allows you to use the actual inputs and outputs of your 
target during simulation of the code. 
CodeWarrior supports ICS kits. ICS kits are NOT being created for new 
HC08 derivatives. The same support is provided with the USB Mon08 
Multilinks. 

8.5 Modular Evaluation System (MMEVS) 
The Modular Evaluation System (MMEVS) is Freescale's two-board 
emulator for the 68HC(9)08 Family of microcontrollers. The MMEVS 
consists of a Platform Board and an Emulator Module (EM) which adapts 
emulator functionality to any of a variety of 68HC(9)08 microcontrollers. 
Connected to your target system, the emulator replicates the actual target 
system MCU.  
Use this economical system to perform traditional debugging activities such 
as executing code in run or step mode, setting break points, monitoring or modifying CPU registers, memory 
and application variables, and creating log or script files to record test results or create test suites. 
CodeWarrior supports MMEVS. 
 

8.6 Modular Development System (MMDS) 
The Modular Development System (MMDS) is a full featured emulator 
system for developing embedded systems using 68HC(9)08 microcontrollers.  
In addition to incorporating the debug features of the Modular Evaluation 
System (MMEVS), the MMDS adds advanced features such as real-time, 
dual-ported memory and a bus state analyzer to capture user-defined bus 
cycles or events. Use the dual-ported memory to tune filter circuits or 
monitor changes to program variables while your program is running at full 
speed. Verify nested or complex program flows using the bus state analyzer's 
full range of sequenced or logical event triggering and data capture modes. 
CodeWarrior supports MMDS. 

 

8.7 Freescale In-Circuit Emulator (FSICE) 

The Freescale Semiconductor in-circuit emulator (FSICE) is a full-
featured emulator system for developing embedded systems using 
HC08 microcontrollers. The FSICE system consists of a base 
station and a MCU emulator module (EM). Connected to your 
target system, the emulator replicates the actual target system 
MCU. The CodeWarrior development environment (IDE) interface 
allows for quick edits and changes to assembly code, which makes design, debug, and real-time evaluation of 
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the target system as efficient as possible. Use this economical system to perform traditional debugging 
activities such as executing code in run or step mode, setting break points, monitoring or modifying CPU 
registers, memory and application variables, and creating log or script files to record test results or create test 
suites. 

In addition to incorporating the debug features of the traditional emulators, FSICE adds advanced features 
such as a built-in USBMULTILINK08 cable for in-circuit Flash programming, Ethernet interface for remote 
debugging and application development, and real-time bus analyzer with 24 general-purpose logic inputs for 
capture user-defined bus cycles or events. The bus state analyzer can also help a designer debug the MCU 
support circuitry, verify nested or complex program flows using the full range of sequenced or logical event 
triggering and data capture modes, and ensure proper timing by using the custom time tag clock. 

The FSICEBASE currently supports the following EM Emulation Modules: 

EML08AB32  
EML08AP  
EM08AS60  
EM08AZ60  
EM08BD48 
EM08EY  
EML08GP32 

EML08GPGT 
EML08GZ 
EML08GZ16  
EM08JB 
EML08JBJG 
EML08JL8  
EML08JLJK 

EM08JW32 
EM08LB8 
EML08LD64  
EML08LJ12 
EML908KX  
EML08LJLK 
EM08MR8 

EM08MR32       
EML08QBLTY 
EML08QCBLTY 
EML08QL 
EML08QTQY  
EML08RK/RFRK 
EML08SR  

9  Hardware Products: Part numbers 
 

Product Part number 
USB to Mon08 Multilink cable (HC08 only) USBMULTILINK08E 

USB to BDM Multilink cable (HCS08 and HCS12) USBMULTILINKBDME 

Cyclone Programmer Serial/USB/Ethernet M68CYCLONEPROE 

SofTec inDART products Call SofTec or Distributors 

ICS In-Circuit Simulator (device specific) ICS08xxx 

MMEVS (requires device specific EM Emulation Module) M68MMEVS0508 

MMDS (requires device specific EM Emulation Module) M68MMDS0508 

FSICE (requires device specific EM Emulation Module) FSICEBASE 
 

10 Pricing 

For reasons of consistency, pricing is not published in this document. Please consult the Product Availability 
Guide or contact the nearest Freescale office. 

11 Licensing 

CodeWarrior Development Studio for HC(S)08/RS08 can be licensed in different ways: 

- The Special Edition license key is “free of charge” and installed with the product. 
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- The Standard and Professional Editions require license keys that can be floating licenses, dongle 
licenses or node locked to a computer 

12 Getting started with Special Edition 

12.1 Option 1: Obtaining the CD 

There are several ways to obtain the CD containing CodeWarrior Development Studio for HC(S)08. 

12.1.1 On-Line buy 

CodeWarrior Development Studio for HC(S)08/RS08 can be purchased directly from our 
Web site: 
Link to Buy Direct 

12.1.2 On-line Request 

This is a link for on-line request for an evaluation CD 
In case of difficulty, contact your Freescale sales office or distributor. 

12.1.3 Request from Freescale LDC 

Freescale Literature Distribution Center (LDC): 1-800-441-2447 

Request: CWX-HXX-SE 

12.2 Option 2: Downloading the software 

CodeWarrior for HC(S)08 
CodeWarrior for HC(S)08 can be downloaded from our Web site: 
http://www.freescale.com/cw5 
 
Select “Download”. The first time, you will be presented with a questionnaire. Fill in this 
questionnaire and submit it. Immediately, you can download the .exe file containing the CodeWarrior 
software. 

 
Service Packs 

Freescale is committed to supporting the family of HC(S)08 products with the best possible 
development tools. New derivatives are also introduced that may require dedicated files or software 
modules to be supported by the existing version of the tools. Service packs are made available for 
download on Freescale web site. Visit: 
 
Link to download HC(S)08 Service Packs 
 
Click on the link for “Updates and Patches”, this will take you to the page with the service packs 
available for a specific CodeWarrior release. 
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13 Getting started with Standard or Professional Editions 

13.1 Ordering 

Standard Edition, Professional Edition, yearly technical support packages and upgrade packages can 
be ordered directly from the Freescale WEB site: 

Click on the following link to on-line store for HC(S)08 products 

13.2 Registering and getting a license 
You need a license key to activate the Standard Edition or the Professional Edition. You can register 
your product directly from the CodeWarrior IDE. Select Help > Register Product from the main 
menu — the CodeWarrior IDE starts your browser, taking you to Step 1 of the on-line registration 
form 
 

Registration Form Step 1 

 
 
Enter your email address in the appropriate fields. Click on the Begin Registration button and the 
second screen appears. Follow on-screen instructions to complete remaining pages of the form 
(Thank You page is last) — within a few minutes Freescale will email your license authorization 
code. 
 
When you receive the email, select Help > License Authorization from the CodeWarrior main 
menu. The Licence Authorization dialog box appears. Paste the license authorization code from the 
email into the License Authorization dialog box. When you click the OK button — the License 
Authorization dialog box updates and the IDE automatically gets the license key and installs it in the 
correct location. 
 
NOTE: If you downloaded the software from the Freescale web site, you might not have a 
registration code. You can request a registration code from license@freescale.com. Special 
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Edition customers do not need to register. The Special Edition license file is automatically installed 
with the software. 

13.3 Manually installing the key 
To manually install the license key follow the steps below. You can find the license.dat file in the 
directory where you installed the CodeWarrior software. The default is: C:\Program 
Files\Freescale\CW08 V5.0 
 
- Open license.dat 

o Start a text editor such as Notepad 
o Open license.dat fileendix B: Manually Installing License Key 

- Copy license key you received from Freescale 
- Paste license key on new line at bottom of license.dat file 
- Save license.dat file 
- Close license.dat file – license is installed; IDE uses new license next time you start the 

CodeWarrior IDE 
 
NOTE:  Do not move or delete the license.dat file. If you receive additional keys for other 
CodeWarrior components, you can add the additional keys to the license.dat file. 
 

14 Tutorials 
We have developed five tutorials to help developers get 
acquainted with the rich feature set of the CodeWarrior tools. 
These tutorial include:  

- Assembly Tutorial,  
- C Tutorial,  
- Processor Expert,  
- Assembly with Device Initialization,  
- C with Device Initialization.  

You can access these tutorials from the Startup Dialog in 
CodeWarrior Development Studio for HC(S)08/RS08 v5.0.  

15 Training 
You can access on-line training on the Freescale WEB site at Technical Learning Center. 

16 Useful Links 
To visit CodeWarrior site or get technical support: 
 
CodeWarrior:   http://www.freescale.com/codewarrior 
 
Technical Support: http://www.freescale.com/support 
 

Links to our Processor Expert tool and related beans: 
http://www.processorexpert.com 
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For introduction on the beans 

http://www.processorexpert.com/eb/main.html 
 
For details on beans to support external devices (A/D, displays, other beans) 

http://www.processorexpert.com/eb/hw_beans.html 
 
For details on software only beans (data processing, process control, other beans) 

http://www.processorexpert.com/eb/sw_beans.html 
 
For details on beans related to internal MCU modules (SCI, SPI, A/D, other beans) 

http://www.processorexpert.com/eb/basic_beans.html 
 
When you get to individual beans, the left menu allows you to see details and usage example. 

 
Links to board vendors: 
 

SofTec Microsystems:  http://www.softecmicro.com 

Future Electronics:  http://www.futureerc.com 

17 Benchmarks 
Benchmarking probably is an 'art' for itself. It may be difficult to find the 'ideal' switches for benchmarking. 
It heavily depends on the benchmark and the goal you want to achieve. Code density is one thing, and code 
speed another. The compiler manual already lists an option set for 'general' purpose, and the 'Smart Sliders' in 
the compiler are helping in this area too. 
 
There are several aspects to consider in optimizing the code and the result will be a best combination of these 
rather than one only piece. If compiler switches play an important role, the way the linker is used plays a 
significant role for the final application as well as the programming style and the goals to achieve. 
For a very critical benchmark, we suggest that customers work with our engineering team which already has 
a lot of expertise and, quite important, they know their tools best. 

18 Documentation 
There is a lot of documentation available: 

- Direct ‘F1 key’ help from inside the CodeWarrior applications,  
- Manuals, tutorials, examples in the CodeWarrior software,  
- Manuals on the CD. 

 
There is a lot of documentation on the different components of CodeWarrior Development Studio.  
All the manuals can be found on the CD and can be installed on the hard drive, depending on the installation 
chosen. Look for the folder “CodeWarrior Manuals” on the CD or in the directory where CodeWarrior 
Development Studio is installed. 
 
Printed manuals can also be ordered from the Freescale Literature Distribution Center (LDC): 1-800-441-
2447. 
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19 Questions and Answers 
� Q: Where do I find the manuals for CodeWarrior tools, especially on Processor Expert? 
 A: Within CodeWarrior, use the Processor Expert menu and chose the documentation you want. 

There are html and pdf version of the documentation, if that was installed, in the CodeWarrior 
folder: C;\\….\CodeWarrior…\Bin\Plugins\Support\ProcessorExpert\ 

 There is also information and links on CodeWarrior web pages under ‘Processor Expert’. 
 
� Q: Is there a flash-programming capability without opening CodeWarrior tools? 
 A: In the CodeWarrior folder where software was installed, there is a PROG folder containing the 

program BURNER.EXE. Double-click on it and you have the function. 
  
 There is a manual too: In the CodeWarrior folder where software was installed, there is a 

CODEWARRIOR MANUALS folder, in the PDF folder open the MANUAL_BURNER.PDF file. 
There are several shortcuts to the burner already and they can be accessed out of the project 
preference panels too (burner preference panel). 

 
� Q: Is there added support for new derivatives in older versions of CodeWarrior? 
 A: No. Development effort is made on the most recent release of the tool suite. Adding new 

derivatives requires some effort especially in the testing of all combinations, all derivatives to make 
sure nothing has been ‘broken’ in CodeWarrior tools. Retrofitting previous releases would add 
significant load to the engineering team and we need to focus on improving the tools and supporting 
quickly new derivatives.  

 


